@j RIPE NCC

#infoRedes #NetOX
#RIPEstat

RIR Collaboration on
RIPEstat



What is RIPEstat? &

* Open data platform for RIPE NCC data
- RIPE Database, RIS and RIPE Atlas

e |[nformation service for Internet-related data

* |nsight through statistics!
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RIPEstat Data Sources Available

® More than 25 different datasets MLAB

- RIPE Database (INR, IRR) and other RIRs BI@ADBAND
- BGP routing data (RIS) e =
- RIPE Atlas, M-Lab, Speedchecker etc.

MAXMIND

-

- Geolocation

. SPAVIHAUS
- Blacklist

i  ————

- More details at https://stat.ripe.net/data-sources

® New datasets are constantly added!

Christian Teuschel | ESNOG 24 | October 2019
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RIPEstat APIs

Search
B2 ik P Profix Overview (193.0.20.0/23) Geoloc (193.0.20,0/23)
. —Ee

Liedan
| Sl German
Nag Uatli * Fenms of Use  Report amp ener

[ ]
O ) |
DNE This prefix is announced by S
Ams im £
- - I = Antl Abuse AS3333 '.!_,,,,;

GOBC

» Geoloc details

Activity SNOW IANA Registry hfarmaticn I
__ Data is based on MaxMind's Geolite City |
Suggestions P data setand valid for the stated query
Sty TS for 1S J00/2 5 of TS5 23 (0D tirme (sée below)
X sarce dat ertond core prrmadnk ik

Registry Browser (193.0.20.0/23)

Prefix Overview (140.78.0.0/16)

This prefix is announced by
AS1205

JKU-LINZ-AS University

» RIPEstat widget A

Linz, AT

and is part of 140.0.0.0/8, Legacy space,
administered by ARIN. &

. Showing resutts for 140.78.0.016 as of 2014-04-07 08:00:00 UTC
source data embed code permalink Info

— E—

- https://stat.ripe.net/data/routing-status/data.json”?
resource=...
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https://stat.ripe.net
https://stat.ripe.net/data/routing-status/data.json?resource=
https://stat.ripe.net/data/routing-status/data.json?resource=

RIPEstat Data API
e JSON-RPC API

- E.qg. https://stat.ripe.net/data/prefix-overview/data.json?
max_related=50&resource=193.0.20.0%2F23

e More than 50 data calls

e Documentation

- https://stat.ripe.net/docs/data_api

Christian Teuschel | ESNOG 24 | October 2019



RIPEstat Widget API
e HTMLS5/CSS/JS applications

e Standard Javascript

- JQuery

- Require.|s
* More than 50 widgets

e Documentation

- https://stat.ripe.net/docs/widget_api

Christian Teuschel | ESNOG 24 | October 2019




RIPEstat Widget API

e Building blocks of RIPEstat web interface

https://stat.ripe.net

@ RIPE NCC

Christian Teuschel v _‘@

Manage IPs and ASNs >

4

|

Website
RIPE NETWORK COORDINATION CENTRE Search IP Address or ASN Q l
Analyse Participate > Get Support Publications About Us >
You are here: Home > Analyse > Statistics > RIPEstat
RIPEstat
Enter an IP address/prefix, ASN, country code or hostname Go
Your network: AS3333, 193.0.20.0/23 Tryone of these: IPv4 prefix, IPv4 range, IPv6, ASN

Twitter Feed

#RIPEstat 0
Apr 05, 2018
ﬂ Chnstlan (RIPEstat) »
Using RIPEstat to Analyse Cable Cuts in Chile
#RIPEstat feature fact: Every widget shows jan 05, 2018
in the bottom for which resource and time o -
the output is valid! BGP Meets Cat
jun 26, 2017

RIPE Labs Feed

RIPEstat Links

About RIPEstat

Get general information about RIPEstat

Documentation

Access the documentation for all RIPEstat APIs

Use Cases

Read about use cases for RIPEstat

Christian Teuschel | ESNOG 24 | October 2019




Usage of RIPEstat &
¢ RIPEstat is popular!

- ~100 million requests per day

- More than 1.5 million unique clients/IPs (daily)

RIPEstat Data API

sssssssssssssssssssssssss

RIPE NCC » W

Survey 2019 Report

“‘RIPEstat is the most used tool of the RIPE NCC tools and services...”
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Usage of RIPEstat

e R|IPEstat has a very diverse user base

Country

COUNTRY v VISITS
BE  United States 23.2% 34,207
B Germany 7.9% 11,609
B Russia 7.4% 10,978
k=  United Kingdom 7.2% 10,569
mm Poland 5% 7,385
== Netherlands 31% 4,541
== Spain 3% 4,384
B} France 2.8% 4130
Bl ttaly 2.8% 4,101
= Iran 2.7% 4,013
B kraine 2.3% 3,372
&l Brazil 1.7% 2,454
Turkey 1.6% 2,296
g Slovenia 1.4% 2,014
Switzerland 1.2% 1,791
Rm Czechia 1.2% 1,762
t®. South Korea 1.2% 1,762
] Romania 1.2% 1,753
® Japan 11% 1,633

— —
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Usage of RIPEstat

e Despite this diverse user base, users from
other RIR regions are underrepresented

e Possible reasons

- Lack of knowledge about the service
- Language barrier

- Not addressing local topic

® We believe we can improve these points
through cooperation with other RIRs

Christian Teuschel | ESNOG 24 | October 2019 10



RIR Cooperation

® Phase 1
- Customisation of the Ul to LACNIC’s design

- Localisation of textual content

¢ Phase 2

- Cooperation on system operation and dataset provisioning

- Example for dataset provisioning: collaboration on BGP
route collectors between APNIC, LACNIC and RIPE NCC
(already ongoing)

- Phase 1 and 2 are independent for data set provisioning

Christian Teuschel | ESNOG 24 | October 2019 11



Phase 1 Details &

® Customisation of the Ul to LACNIC'’s
design

- The goal is to provide Ul that reflects the affiliation to
LACNIC. Users that go to stats.lacnic.net will see RIPEstat
loaded with a LACNIC customised template e.g. LACNIC
logo, header and footer. In the simplest case this requires a
DNS entry for stat.lacnic.net pointing to RIPEstat and
adaptions in the Ul logic

® Localisation of textual content

- The text that appears in RIPEstat widgets would be
translated to Spanish and Portuguese. This would require
language support in RIPEstat and the translation efforts

Christian Teuschel | ESNOG 24 | October 2019 12


http://stats.lacnic.net
http://stat.lacnic.net

Benefits

® Improved usability for users in LACNIC
region

- Catering for regional information requirements
- Removing language barrier

- Access to regional datasets

- Ability to show and share local events

- Establishing feedback channel for regional matter to
RIPEstat

Christian Teuschel | ESNOG 24 | October 2019
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InfoRedes

& inforedes.labs.lacnic.net

ESPANOL ENGLISH PORTUGUES

lacnicinforedes

Informacioén acerca de recursos de numeracion de Internet utilizando RIPEstat. Ingrese una direccion o prefijo IPv4, IPv6 o un ASN para
obtener informacion sobre routing, conectividad, RPKI y otra informacion (til para operadores de red.

’refijo, ASN o Nombre de Dominio m

Tu red: AS3333 2001:67c:2e8::/48 Prueba alguno de estos ejemplos: Prefijo IPv4, Prefijo IPv6, Rango IPvé, ASN

CASA DE INTERNET O 0 (in) (it

DE LATINOAMERICA Y EL CARIBE

, Rambla Republica de México 6125
Montevideo, Uruguay
+508 2604 2222 FAX int. 4112

Este sitio web utiliza cookies, si permanece aqui acepta su uso. Puede leer mas sobre el uso de cookies en nuestra

Christian Teuschel | ESNOG 24 | October 2019
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InfoRedes

e | ACNIC’s themed version of RIPEstat

* | ocalisations
- Content
- Decisions
- Language

- Feedback

Christian Teuschel | ESNOG 24 | October 2019
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InfoRedes

e | ACNIC’s themed version of RIPEstat

* | ocalisations
- Content
- Decisions
- Language

- Feedback
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InfoRedes

e | ACNIC’s themed version of RIPEstat

* | ocalisations
- Content
- Decisions
- Language

- Feedback
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InfoRedes

e | ACNIC’s themed version of RIPEstat

* | ocalisations
- Content
- Decisions
- Language

- Feedback
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InfoRedes

e | ACNIC’s themed version of RIPEstat

* | ocalisations
- Content
- Decisions
- Language

- Feedback
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InfoRedes

e | ACNIC’s themed version of RIPEstat

e | ocalisations

- Content
- Decisions
- Language
- Feedback
* Powered by RIPEstat Data API

* |[mplementation took two weeks

Christian Teuschel | ESNOG 24 | October 2019
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InNfoRedes
1
lacnlcews

Casa de Internet Cooperation Cybersecurity Events IPv6

Internet governance LACNIC Policies Research Training

RESEARCH

Cambiar tamano de fuente: |12 @ INSTITUTIONAL

30/09/2019

LACNIC Presents Inforedes: the Single
Window for Open Data from Internet

Resources
R —————
https://prensa.lacnic.net/news/en/research/lacnic-presents-

inforedes-the-single-window-for-open-data-from-internet-resources
Christian Teuschel | ESNOG 24 | October 2019



https://prensa.lacnic.net/news/en/research/lacnic-presents-inforedes-the-single-window-for-open-data-from-internet-resources
https://prensa.lacnic.net/news/en/research/lacnic-presents-inforedes-the-single-window-for-open-data-from-internet-resources

InfoRedes

e https://inforedes.labs.lacnic.net

* Product manager: Guillermo Cicileo /
guillermo@lacnic.net

@ inforedes.labs.lacnic.net

ESPANOL ENGLISH PORTUGUES

lacnicinforedes

Informacién acerca de recursos de numeracién de Internet utilizando RIPEstat. Ingrese una direccion o prefijo IPv4, IPv6 o un ASN para
obtener informacion sobre routing, conectividad, RPKI y otra informacion util para operadores de red.

2001:67c:2e8::/48 ENVIAR

Tu red: AS3333 2001:67¢c:2e8:/48 Prueba alguno de estos ejemples: Prefijo [Pvd4, Prefio Pv6, Rango Pvé, ASN
Vista Rapida Enrutamiento Geolocalizacién Sugerancias

Prefix Overview (2001:67c:2¢8::/48) Maxmind Geolite (2001:67c:2¢8::/48)

Routing information
(RIS)
Is visible as exact BILL
match
No more/less-specific

prefixes are visible

This prefix is announced by: +

AS3333 - APKI Status: @
“RIPE-NCC-AS - Reseaux IP Europeens Network Coordination
Centre (RIPE NCC)"

Christian Teuschel | ESNOG 24 | October 2019


https://inforedes.labs.lacnic.net

NetOX - Network Operators Toolbox

o https://netox.apnic.net

* Product manager: Sofia Silva Berenguer /
sofia@apnic.net

G
=
u]

& netox.apnic.net

APNIC NetOX = APNIC NetOX > search > AS3333

Search Internet Number Resources

This is APNIC's Network Operators ToolbOX, powered by RIPE NCC's RIPEstat. Itis currently just a prototype. If you have any
questions or comments, please send them through using the Feedback button on the right. Thanks!
E.g. AS4608, 2001:dc0::/32, 202.12.31.0/24

Useful Links AS3333 o

RV
]
I
S
Disclaimer ]
g

At a Glance Routing DNS Anti Abuse Database Geographic RQC Activity

AS Overview (AS3333) Whois Matches (AS3333)

Routing information (RIS) + Whois results (1)

Originates prefixes visible shicw riora flelds

Is seen in other routes

2 3333
num
Name and holder of this ASN: a5 RIPE-NCC-AS
name
Reseaux |P Europeens Network
descr

Coordination Centre (RIPE NCC)
org ORG-RIEN1-RIPE
status ASSIGNED

RIR Status Registration Country

Christian Teuschel | ESNOG 24 | October 2019


https://netox.apnic.net
mailto:sofia@apnic.net

Questions

christian.teuschel@ripe.net
@christian_toysh




") RIPE NETWORK COORDINATION CENTRE

RIPE Atlas

Global Measurement Network

Christian Teuschel | October 2019 | ESNOG 24



RIPE Atlas &

e ....Is aglobal, open, distributed Internet measurement platform,
consisting of thousands of measurement devices that measure
Internet connectivity in real time

Christian Teuschel | ESNOG 24 | October 2019 2



Global active measurements platform (.

 Goal: View Internet reachability
* Probes hosted by volunteers
e Measurements towards root name servers

- Visualised as Internet traffic maps

* Users can also run customised measurements
- ping, traceroute, DNS & SSL/TLS, NTP and HT TP~

e Data publicly available

Christian Teuschel | ESNOG 24 | October 2019 3



RIPE Atlas measurements &

e Built-in global measurements towards root nameservers

- Visualised as Internet traffic maps

e Built-in regional measurements towards “"anchors”

e Users can run customised measurements
- ping, traceroute, DNS, SSL/TLS, NTP and HTTP

Christian Teuschel | ESNOG 24 | October 2019 4



Probes and Anchors

10,000+ probes connected (almost 500 Anchors)

e 7,500+ results collected per second
e 21,000+ measurements currently running

Christian Teuschel | ESNOG 24 | October 2019



RIPE Atlas Overwew

e 00 TR TS TS T T e T e e e e weee e

Web Interfac

Control

Data Repository

Streaming
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RIPE Atlas Global Coverage
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&

Most Popular Features

e Six types of measurements: ping, traceroute, DNS, SSL/TLS,
NTP and HTTP (to anchors)

e APIls and CLI tools to start measurements
and get results

e Streaming data for real-time results

e Status checks

Christian Teuschel | ESNOG 24 | October 2019 8



Using
RIPE Atlas As a Visitor




Internet Traff

RIPE Atlas «

About RIPE Atias >

Get Invoived >

Probes and Anchors >
Measurements

Internet Maps

Tools

Resources >
RIPE NCC Members

My Atlas >

Staff Pages >

Ic Maps

Internet Maps

DNS Root Instances

Shows, for each probe, which root DNS
server instance the probe ends up
querying, when they ask a particular
root server. In other words, it shows the
"gravitational radius" for root DNS
server instances.

RTT to Fixed Destinations

Bt )

Shows the colour coding for the RTT
value for the particular destination for
each probe, The minimum / average /
maximum values are based on standard
"ping” measurements.

Comparative DNS Root RTT

Shows a comparison of response time
for DNS SOA queries to all the root DNS
servers. For each probe, a marker
shows the "best" root server with colour
identifying the related minimum
response time.

Reachability of Fixed
Destinations

Shows if the particular fixed destination
is reachable or not from each probe.
Red markers indicate that the specific
destination for these probes are
unreachable and green reachable.

Christian Teuschel | ESNOG 24 | October 2019

Root Server Performance

.
T
4 SNt

This map shows the reply time to the
SOA query of a particular root DNS
server, over the selected transport
protoco! (UDP, TCP or comparison of
the two) for each probe.
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Where is B-root?

We display measurement results from the last hour only.

.

e

O s —

Leafiet | Tiles © Esri — Est, DeLorme, NAVTEQ.

Christian TeuschnerpPrESNOSZE TOCIODET ZUTY

—
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Probes per country (in RIPEstat)

”~

-

o
RIPE Atlas Probes (es)

Switch to table view
Found 391RIPE Atlas probes in this network:

\7 Connected (158) Abandecned (217) V Disconnected (16)

: £ 6;35; r o
Map Satellite S, S | L S
Italy )
3 ®Rome ‘

I'yirhenian Sea

Meditarraneal

_ “Tunisia
’
Morocco, = Nl 4
VAV
\ Algeria f—
Google | — e
g Western _ Map data ©2019 Google, INEGI, ORION-ME  Terms of Use
Showing results for es
source data embed code permalink Info

"

R —— e

https://stat.ripe.net/es#tabld=activity
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Probes per country (in RIPEstat)

5
RIPE Atlas Probe Deployment (es)

O Multi-resource

250 RIFEstat
200 , - -
150 14
ety Monday, Oct 7, 2019
100 g™ » Spain(abandoned): 217
/ * Spain(connected): 157
e Spain(disconnected): 17 |
50 —
0
2015 2016 2017 2018 2019
-»- Spain(abandoned) - Spain(connected) Spain(disconnected)

Showing results for cc_es as of 2019-10-08 09:00:00 UTC

source data embed code permalink Info

e ——— —————

» https://stat.rige.net/es#tabld=activity
Christian Teuschel | ESNOG 2 clober


https://stat.ripe.net/es#tabId=activity

Where we want to place probes

Christian Teuschel | ESNOG 24 | October 2019
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Looking Up Public Probes




Searching for Probes

RIPE NETWORK COORDINATION CENTRE

@ RIPE NCC

Manage IPs and ASNs >

Analyse

Participate >

b You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Probes

W

Probes

This is a list of all current RIPE Atlas probes, including information specific to each probe. More probes are continually coming online, __

e [ earn more about probes

e See the probes map

® Apply for your own probe

Public Login to see more

Id ASN v4 ASN v6
6175 1103 1103
6146 60781 60781
6152 28753 28753
6137 3333 3333
6147 33280 33280
6112 197216 197216
6161 27843 27843
6142 63403 653403
6008 2607 2607
6001 3333 3333

Country

BFLH AT

L=
>
E

1K IF

Filter by id/asn/country/description

Description

SURFnet bv

Leaseweb Network B.V.
Leaseweb Network B.V.
ni-ams-as3333-preprod
Afilias

Delta Softmedia Ltd
Optical Technologies
Afilias

AA sk-bts-gs2607

Lo
‘‘‘‘ Website
Search IP Address or AS! Q
Get Support Publications About Us > »
=
_ =
Any Status _'J IPvaivé ~ Any Country ;l n
Connection Status e
& 4 weeks ol
& 4 weeks =y
& 4 weeks -
& 4 weeks o
& 4 weeks @
O 4 weeks ol
& 4 weeks o
& 4 weeks o
& 4 weeks -
& 4 weeks o

AA nl-ams-as3333

Christian Teuschel | ESNOG 24 | October 2019

https://atlas.ri

_—

—
s

7" Filter based on \\

ASN, country,

location...
A

e.net/

~3 —
N

N

robes/
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https://atlas.ripe.net/probes/

Probe Page

y You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Probes > Probe #10010

PrObe #1 001 0 (Register) === & 3days, 9 hours
a=
Firmware
General Network Built-in Measurements User-defined Measurements 5 #1001 O
- - . Architecture
General Information Connection & Traffic & N
Id 10010 (e)Bits/s_ Packets/s MAC Address
F8:D1:11:AS:F3:2C
MAC F8:D1:11:A9:F3:2C oK
Address
2.5k ; . . .
Architaciire U696 %W The displayed location is an
automatic best guess of the
\F?rm.ware 4680 (1070) : 08:00 12:00 city based on IP address.
ersion
By manually setting a more
Router Type 4T & orii e accurate location you can help
Bandwidth  Not set Connected Time B to improve the usefulness and

Limit correctness of RIPE Atlas.
DNS Entry  Off

Shared Yes April May Update Location (¢

Publicly
User Tags +
?
System - Het I
Tags
Management Sharing

Only the probe host is permitted to administer this probe.

Christian Teuschel | ESNOG 24 | October 2019



Zoomable Ping Graph

* Replace multiple RRD graphs: zoom in/out in time, in the same
graph

e Easier visualisation of an event's details

* Selection of RTT class (max, min, average)

Current data point resolution : no aggregation applied B zoom out # download
2
2015- 5 UTC
RTT Mi s
.
RTT Max
)
E RTTM
E 1 :
e

07:00 08:00 09:00 10:00 11:00 12:00 13:00 14:00
Minimum  Average Maximum  95th percentile
— RTT Min 0.582ms 0.62ms 0.65ms 0.64ms
— RTT Med 0.613ms 0.65ms 0.791ms 0.698ms
— RTT Max 0.673ms  0.77ms 1.63ms 0.862ms

o No data o =0% a >0% a >30% s >60% = 100% Pkt Loss o 0 Pkts sent

Showing results for 10010/2 from 2015-05-22 06:21:40 UTC to 2015-05-22 14:17:42 UTC

Christian Teuschel | ESNOG 24 | October 2019
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Searching probes with the API

 endpoint https://atlas.ripe.net/api/v2/probes/

o different formats, €.9. geojson

_ (il RIPE Atlas api - RIPE Atlas — . X S

&

C @

& https://atlas.ripe.net/api/v2/probes/27460 B --9UQw I @O ¥ ¥ O »
Login
RIPE NCC
] RIPE NETWORK COORDINATION CENTRE Search IP Address or ASN Q I
Manage IPs and ASNs > Analyse Participate > Get Support Publications About Us >

!

’ You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Not Found API View > Probe List > Not Found

Api view Probe Detail

GET /api/v2/probes/27460

HTTP 200 0K
Allow:
Content-Type:

Vary:

{

"address_v4": "83.160.104.137",
"address_v6": "2001:982:486a:1:c6b6e:1fff:fe5b:ed7e",
"asn_v4": 3265,
"asn_v6": 3265,
"country_code": "NL",
"description": "Jasper Home",
"first_connected": 1476004586,
"geometry": {

“type": "Point",

"coordinates": [

4.8705,
52.3675

1
H
"id": 27460,
"is_anchor": false,
"is_public": true,
"last_connected": 1567673726,
"prefix_v4": "83.160.0.0/14",
"prefix_v6": "2001:980::/30",
"status": {

OPTIONS GET ~

Christian Teuschel | ESNOG 24 | October 2019
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Finding Results of
Public Measurements



Looking up Measurements Results

Manage IPs and ASNs > Analyse Participate > Get Support Publications About Us >

| N

You are here: Home > Analyse > Internet Measurements > RIPE Atlas > Measurements

Measurements

ID
9278562

9278557

9278556

9278555

9278554

9278553

9278550

Search by target

Traceroute DNS

Type
Ping

Ping

Ping

Ping

Ping

Ping

Ping

Target

www.ripe.net

185.15.245.163

123.126.20.54

r1.d1.de.recast-it.net

r1.al.nl.recast-it.net

2001:6a8:28c0:2017::00:00:FF

2001:6a8:28c0:2017::00:00:FF

A

v Search... Any Status ¥ | IPv4/v6

HTTP SSL NTP WiFi Built-in Anchoring

Description

Ping measurement to www.ripe.net

From script for latency checks for Monitoring

check unicom

From script for latency checks for Monitoring

From script for latency checks for Monitoring

Ping 6 BLUE measurement to 2001:6a8:28c0:2017::00:00:FF

Pingb measurement to 2001:6a8:28c0:2017::00:00:FF

Christian Teuschel | ESNOG 24 | October 2019

v Alltypes +

Probes Interval
8 one-off
35 one-off
10 one-off
35 one-off
35 one-off
956 one-off

484 one-off

Time (UTC) + Status

08-09-2017 14:02 O
Never

08-09-2017 13:58 O
Never

08-09-2017 13:51 C
08-09-2017 14:00

08-09-2017 13:50 =
08-09-2017 14:00

08-09-2017 13:50 [
08-09-2017 14:00

08-09-2017 13:49 [
08-09-2017 13:55

08-09-2017 13:42 1
08-09-2017 13:50

PR —

https://atlas.ripe.net/measurements/
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Available visualisations:

e List of probes: sortable by RTT

e Map: colour-coded by RTT

o LatencyMON: compare multiple latency t

O =B
RIPE Atlas ping measurement #1402318 to nl-ams-as1101.anchors.atlas.ripe.net

B0°:
50%
40%
0%
20%
10%

Streaming on @

n =~ = 8 " R o8 -
B8 5-030868 05060 5E060 bo-B8 B 0 0T 0 Bo668 0 BE0 . 086050868 0 Ho o 5000088000800 p0-0068004

£ SE (6 probes)

Probe
6019
6069
6111
6112
10008
10218
10246
10252
10267
10296

v

ASN (v4) S
3333

59469

198068
197216

3851

6876

39608

50288

12322

51214

ASN (v6) $
3333

59469

198068

197216

L A |
S SO -~ S - S - S - A~ A - A

-~
g

Time

2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23
2015-05-19 09:23

® Unreachable

TEAR MECURCUN A

From 2015-08-16 07:51 to 2015-09-16 13:11

id

Probes: 138, 395, 5037, 6049, 6063,
6102

Target: nl-ams-

asl! 101.anchors.atas.ripe.net

i , ? T f o DE(6probes) i
50% it I\ | | )| Probes:57, 7. 435, 779, 612, 994
| '. [\ /1 | f\ Targer: nl-ams-
40% 2 [ | I | | | lasti0t.anchors.atas.rpe.net
30% /\ [ | 1\ I|: \ L sy
5 [\ IR [} q | ll | | 4 |
20%|Fro Q o\ | |7 /\] | PR\
N NN A ATYARY AV
O /g WBOOYY oo foboad gy 0ol
. ] & 2 90
50% ~” b4 8 \ 7% @B (6probes) P
50% g R\ . a [\ f\ 4 /7| [Proves:as, 432, 80, 857, 70, BaB
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Available visualisations: traceroute ()

 TraceMON: network topology, latency and nodes information

 |PMap(beta): hops geolocation on map (prototype)

General Information Probes Map LatencyMON TraceMON IPmap (beta) Results
—e—— CEE)— e [~ e
Traceroutes to 74.125.206.94 from 8 of 10 probes [select] at March 10th 2017, 18:47:31 UTC Noceslebelto Auto | | Reverselcokup (| Country code

Tmmm
*

2 AS35003

Be

=

2K

E EOleeds o =
s~ @ ondoniterdam
@Paris a
; dl"ordeno
P, .
Bostondge = ) <,
\San Jose - ?Washington, D.C. -
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> ANEEIeS” @ipallas;
e 3 Nz 3
s1sms| =4 RIPE NCC 3 N
sima| LN / \
5 5ms. )
o5m \
Py e -
4ams, T~ R E—C —__
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https://labs.ripe.net/Members/massimo_candela/tracemon-traceroute-visualisation-network-debugging-tool
http://github.com/RIPE-Atlas-Community/openipmap

Available visualisations: traceroute

* List of probes, colour-coded number of hops

k www.seil.jp

il & 2014-08-2507:44
Il & 2014-08-2507:41
ifi & 2014-08-2507:43

i & 2014-08-2507:41 329.862 i
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Available visualisations: DNS

* Map, colour-coded response time or diversity

o List of probes, sortable by response time
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DNS measurement to ns1.opteamax.de

General Information Probes Map Download Results Modification Log
Probe $ ASN (v4) ¢ ASN (v6) $ $ $ Time

17840 6327 i1 &  2015-05-1909:38
18035 43030 — &  2015-05-1909:50
18129 327805 o 2015-05-19 09:49
15844 32098 il &  2015-05-19 09:48
17857 852 M o 2015-05-19 09:37
189894 6327 [ I+ 2015-05-19 09:36
19204 21513 3 B+ 2015-05-19 08:50
15922 30036 £ &  2015-05-1909:47

Name

null
null
null
null
null
null
null

null

R —

Response Time

=




Downloading Measurements Results

e Click on "Results”, then "Download”
e Or URL

@ O I AP I ¥ Calibration for anchoring measurement: IPv6 Traceroute for
ke-nbo-as37578.anchors.atlas.ripe.net

. General Information Probes Map OpeniPMap Prototype
® I {es U ItS I n J S O N Download the raw measurement result data here.

You can use this form to download the data through your browser, or use the preview on the right to help you query the REST

I u I n f u API directly.
I g Select Your Timeframe URL Preview

Start 2017-05-13 (start time of this measuremer 3 https://atlas.ripe.net/api/v2/measurements/9304

Date*: 064/ results/?start=1505260800&stop=1505347199&f
All dates are start-of-day i

Stop 2017-09-13 (start time of this measuremer 2

Date*:
All dates are end-of-day

Format: ’ ISON s }

L — e
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Looking at the Result

[{“af":6,"avg" 61.32,
"dst addr":"2a00:1450:4004:802::1014",“dst name":"www.google.com",
“dup":0,
“from":"2001:8a0:7£f00:b201:220:4aff:fec5:5b
“fw":4660,"1ts":411,

“max”:62.148, "min":60.372,

“msm 1d":1004005, "msm name":"Ping",

"prb i1id":722,"proto":"ICMP", "rcvd":10,

sresult":[{"rtt":62.148}, {"rtt":61.437},{" "rtt":61.444},{"rtt":61.448},{"rtt";

60.372},{"rtt":60.373},{"rtt":61.384},{"rtt":61.267}1],
“sent":10,"size"64,
“src addr":"2001:8a0:7£f00:b201:220:4aff:fec5:

"step":240, "timestamp”:1410220847,"ttl1":54,"type" :"ping"},
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rtt"
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Search for Measurements by Target in RIPEstat

RIPEstat — Internet Measurements and Analysis

O
E} IE’.? l .| &5 https @ stat.ripe.net/widget/atlas-targets#w.resource=8.8.8.8

You are here: Home > Data & Tools > RIPEstat > atlas-targets

Go to “RIPEstat > S
“RIPE Atlas Activity” |

RIPE Atlas Measurement Targets (8.8.8.8)

8.8.8.8

Show | 10 % ]targets/page

Measurement
ID

v

1040720 ‘&

1006491 @&
1006192 (@
1004827 &
1002630 (@

1478085 (@

Stopped

ongoing

ongoing
ongoing
ongoing
ongoing

2014-02-24
13:41 UTC
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w

Type -+

ping
traceroute
ping
traceroute
ping

dns

Target
IP

8.8.8.8
8.8.8.8
8.8.8.8
8.8.8.8

8.8.8.5

v

Search:
Target Hostname

google-public-dns-
a.google.com

not specified
not specified
not specified

not specified

not specified
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Finding one specific measurement

* |f you know the measurement ID:

- https://atlas.ripe.net/measurements/ID

- https://atlas.ripe.net/measurements/2340408/
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Use Existing Measurements &

* Many measurements already running!
e Search for existing public measurements first...
* Only then schedule your own measurement
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Creating a Measurement



Benefits of your own measurements

 Customer problem: cannot reach your server

- Schedule measurements (pings or traceroutes) from up to 1,000 RIPE Atlas probes
worldwide to check where the problem is

 Measuring packet loss on suspected "bad” link
e Testing anycast deployment
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Logging In

 Log in to atlas.ripe.ne
- Use your RIPE NCC Access account

- Same account for LIR Portal, RIPE Atlas, RIPEstat,

- Create an account if you don't already have one

‘_ogm
Rl PE N cc RIPE Database (Whois)
RIPE NETWORK COORDINATION CENTRE Search the content of this website Q
Manage IPs and ASNs > Analyse Participate > Get Support > Publications About Us >

You are here: Home > Analyse > Internet Measurements > RIPE Atlas

!

ARGUERIRE Nie 3 With your help, the RIPE NCC is building Probes connected to RIPE - 9397
Get Involved > the largest Internet measurement 3 ’ Allps
network ever made. RIPE Atlas employs a B v
Probes and Anchors > DAl HeroTk B AEabes tRAESiasSCre 4 %; £, :\/Iﬁans':];rements currently 11986
Measurements, Maps and Tools ? Internet connectivity and reachability, " k< W Mg
Resources > provicifig an Unprecedented Results collected per second 3737
understanding of the state of the Internet
RIPE NCC Members in real time.

O\

Already a RIPE Atlas user? Log Find out how RIPE Atlas can
in with your RIPE NCC Access help you monitor your ICANN
account. network, troubleshoot issues,
analyse DNS infrastructure, Become a Sponsor >

test IPv6 connectivity and

Christian Teuschel | ESNOG 24 | October 2019

RIPE Labs...

RI P E N c c RIPE Database (Whois)
RIPE NETWORK COORDINATION CENTRE ,
i Manage IPs and ASNs > Analyse Participate > Get Support > Pu
You are here: Home > Access
Email
Sign in USing your RlPE Your email address
NCC Access account A
If you don't have a RIPE NCC Access Your password
account, click here to create one.
m Forgot your password?

New: Two-step verification. Learn
more...

33


http://atlas.ripe.net

Credits system

e Measurements cost credits

- ping = 10 credits, traceroute = 20, etc.

* Why? Fairness and to avoid overload
e Spending limit and max number of measurements

Christian Teuschel | ESNOG 24 | October 2019
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Credits overview

~ RIPE NCC

RIPE NETWORK COORDINATION CENTRE

Manage IPs and ASNs > Analyse

Participate

RIPE Database (Whois) Website

> Get Support >

You are here: Home > Analyse > Internet Measurements > RIPE Atlas > My Atlas > My Credits

|
RIPE Atlas «
About RIPE Atlas
Get Involved

Probes and Anchors

Measurements, Maps and Tools

NN N N NS

Resources

RIPE NCC Members
Credits
API Keys
Messages
Anchors
Settings

Staff Pages >

My Atlas > Credits

Credits

Here you can see the history of your credit use and current

consumption, transfer credits to someone else, and redeem a
voucher for credits if you have one.

(2] History il Charts & Archives = Transfer = Standing Order

2016-02-02 01:02 UTC

2016-02-02 01:02 UTC
2016-02-01 01:02 UTC
2016-02-01 01:02 UTC
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Give credits
to someone

Comiy
Prob
Probe I
Probe ID:6019 AnchG extra credit
Probe ID:6019 Anchor host 5x extra credit

Probe ID:6019 Anchor uptime 5x extra credit
Probe ID:6019 Anchor host 5x extra credit

Probe ID:6013 Anchor uptime 5x extra credit

Probe |ID:6019 Anchor host 5x extra credit

Publications

& Redeem voucher

Change

+ 108,000
+ 108,000
+ 108,000
+ 108,000
+ 108,000
+ 108,000
+ 108,000
+ 108,000

About Us

153,033,561

9,000.00 credits / hour

Balance

153,033,561
152,925,561
152,817,561
152,709,561
152,601,561
152,493,561
152,385,561
152,277,561
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Scheduling a measurement with the web interface &

* Log In to atlas.ripe.net

 Navigate to Measurements, Maps and Tools -> Measurements In
the left hand sidebar

* Click the green 'Create a Measurement on the right side of the
page
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Scheduling a measurement (2)

Create a New Measurement

step 1 Definitions

ent to bbc.co.uk

Costs summary
Description:

N Daily cost: 10800 credits
You will run out of credits
Ping measurement to bbc.co.uk in about 124 days
An IP address or hostname a >
Interval: -
Address Family™: 240 A
- L 1 3 : ]
Pvd v How often this should be done (seconds ) b ® A
2 = = =
petween samples). Note that this value Is ) % = S
< - -
Packets: lgnored for one-off measurements © B Batance :
3 v I Total Expens
Resolve on Probe: g
Size: Force the probe to do DNS resolution
48 A Users who will supply
credits for this
measurement:
> Advanced Options

ferenc@ripe.net

Step2 | Probe Selection

Worldwide

10

+verse v | v
Step3 | Timing

This is a One-off:

Start time (UTC):

Stop time (UTC):

> Measurement APl Compatible Specification
Christian Teuschel | ESNOG 24 | Oc

@ Create My Measurement(s)
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Scheduling a measurement (3) @)

* Recurring measurement: mostly used for a periodic, long-term
measurement, or..

* One-off measurement: one run on all selected probes.

e Choose type, target, frequency, start/end time, # of probes,
region...

 Each measurement will have unique ID
e “APIl Compatible Specification” is generated too
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Selecting probes with new-set-wizard

o ==
Borkum P2l Selected Probes (12)
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o s 25 b
“—a
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Harling..-—-Lee—; o Gt = en " | = Leer (28 P | — b
_—— a ‘ T
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P - X ——
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| o ) 2 ——
- \ '_EB Probe ID: 21824 Np
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i %. A, 3 el 2 @ Meppen &B .vechta ProbeiD: 15153 =Nb
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w a . / |
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Use Cases




Use cases (1)

Using RIPE Atlas to Validate International Routing
Detours

Anant Shah — 30 Jan 2017

A Quick Look at the Attack on Dyn

Massimo Candela & — 24 Oct 2016
Contributors: Emile Aben

Using RIPE Atlas to Monitor Game Service
Connectivity

Annika Wickert — 14 Sep 2016

Using RIPE Atlas to Measure Cloud Connectivity

Jason Read — 06 Sep 2016

Using RIPE Atlas to Debug Network Connectivity
Problems

Stéphane Bortzmeyer — 10 May 2016

Christian TeusemeM"ESNUG 2 T OCIODEr ZUTY
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RIPE Atlas IXP Country Jedi (1) 2

Do paths between ASes stay in country?
* Any difference between IPv4 and IPv6?
e How many paths go via local IXP?

 Could adding peers improve reachability?

https://www.ripe.net/ixp-country-jedi

 Experimental tool

- Feature requests welcome!

- Depends on probe distribution in country
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RIPE Atlas IXP Country Jedi (2)

e Methodology

- Trace route mesh between RIPE Atlas probes

- Identifying ASNs in country using RIPEstat
- Identifying IXP and IXP LANs in PeeringDB
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Figure 1: Visual representation of IPv4 paths (left) and IPv6 paths (right) between selected RIPE Atlas probes in Sweden
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Use Cases (2)

e DDoS Attack on Dyn DNS Servers (Oct. 2016)

- 10s millions devices - Mirai botnet

- Legitimate requests
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Use Cases (3)

* Monitor Game Service Connectivity (Sept. 2016)
e Requirements:

- Check General Reachability, Latency, Historical data
- Supported by an active and helpful community

- Integrate with their existing logging system

* [rack down an outage in one upstream
e Became sponsors

RIPE Atlas - EU

1d: RTT for N
860
] H
T
mean ripe_atlas_avg_mt, "'rpe_atas_country:IT" = mean rpe_atlas_max_rt, "npe_atlas_t
1d: RTT fi
1o
e 1+
mean fi

5_min_rit, "ripe_atlas_country:GB"
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Use Cases (4)

e Amsterdam Power Outage (March 2015)
 \When and where the outage was happening

Enkhuzen

Katwijk 32m
aan Zee

Wassenaar
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Take Part In the
RIPE Atlas Community



RIPE Atlas community (part 1)

e \Volunteers host probes in homes or offices
e Organisations host RIPE Atlas anchors

e Sponsor organisations give financial support or host multiple
probes In their own networks

Christian Teuschel | ESNOG 24 | October 2019
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RIPE Atlas community (part 2)

e Ambassadors help distribute probes at conferences, give
presentations, etc.

e Developers contribute free and open software

e Network operators create measurements to monitor and
troubleshoot

 Researchers and students write papers

Christian Teuschel | ESNOG 24 | October 2019
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Hosting a probe &

 Create a RIPE NCC Access account
* (Go to https://atlas.ripe.net/apply

* You will receive a probe by post

e Register your probe

* Plug In your probe

 |f you receive a probe from an ambassador (trainer, sponsor,
someone at a conference), just register it and plug it in!
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https://atlas.ripe.net/apply

Questions

christian.teuschel@ripe.net
@christian_toysh




